INSTITUT FUR DEUTSCHE KULTUR UND GESCHICHTE SUDOSTEUROPAS i
INSTITUT FUR ROMANISCHE PHILOLOGIE M

IT-GRUPPE GEISTESWISSENSCHAFTEN
LUDWIG- L

MAXIMILIANS- I samorsmrmey
LMU UNIVERSITAT | [AUDIO-ATLAS £ B |
MONCHEN SIEBENBURGISCH-SACHSISCHER DIALEKTE |

Hinweise fur die Anfertigung von Transkriptionen

Das ASD-Corpus umfasst 2274 Audiodateien, deren Inhalt nur durch Transkription
erschlossen werden kann. Fur die Erfassung historischer und/oder ethnographischer
Information ist eine orthographische und standardnahe Transkription im allgemeinen
ausreichend. Die sprachwissenschaftliche Analyse des Materials hingegen kommt ohne eine
phonetische Transkription nicht aus. Da diese jedoch im Vergleich zu einer orthographischen
Transkription wesentlich zeitraubender ist und tberdies nur von Spezialisten durchgefihrt
werden kann, soll die ErschlieBung des ASD-Corpus durch die simultane Anfertigung von
beiderlei Transkriptionsarten erfolgen. Die orthographische Transkription kann von
sprachwissenschaftlichen Laien angefertigt werden. VVoraussetzung ist jedoch, dass diese den
siebenburgisch-séchsischen Dialekt verstehen.

Regeln

Im Normalfall werden die Transkriptionen - sowohl die orthographischen wie auch die
phonetischen - unter Verwendung des kostenlos verfligbaren Programmes "Praat”
transkribiert (http://www.fon.hum.uva.nl/praat/). Eine ausfuhrliche Anleitung zur
Verwendung von Praat findet sich weiter unten in Anhang I1.

Fur die Transkription dirfen *ausschlieBlich* die folgenden Zeichen verwendet werden:

ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopgrstuvwxyz

Alle anderen Zeichen kénnen bei der elektronischen Datenverarbeitung zu mehr oder weniger
groRRen Problemen fiihren. Das gilt auch fur die deutschen Umlaute und das scharfe "s™ (B).
Diese missen durch "a#", "o#", "u#" und "s#" wiedergegeben werden.

Fur die phonetische Transkription sind von den Autoren des Programmes Praat Regeln
festgelegt worden, wie die Zeichen des phonetischen Alphabets unter ausschliellicher
Verwendung der oben gelisteten Zeichen wiederzugeben sind (s. Anhang I1).

Bei der orthographischen und standardnahen Transkription ist Folgendes zu beachten:
die Morphologie wird dem Standard angepasst, dialektale Formen werden jedoch in spitzen
Klammern erhalten.

Wenn sie sich auf Einzelworter beziehen, werden sie *nachgestellt*:

gewesen<gewest>

der<das> Saal

wahrscheinlich<ken sei>.



Bei Mehrwortausdriicken und phraseologischen Wendungen wird der dialektale Ausdruck in
spitzen Klammern als 6ffnendes Glied *vorangestellt*, durch den Standardausdruck
wiedergegeben und am Ende des Standardausdrucks mit </> abgeschlossen:

<in die Rent kommen>ins Lot kommen</>

<e broien>zu brennen</>

<ister>auf einmal</>

Fremdsprachige Passagen werden wie folgt markiert:
<f>fremdsprachige Passage</f>
Dabei werden fur f folgende Sprachkdirzel eingesetzt:

r = rumanisch; u=ungarisch; rus=russisch; ukr=ukrainisch; d=hochdeutsch;
jid=jiddisch; engl=englisch;

Die deutsche Ubersetzung langerer fremdsprachiger Passagen wird in die Anmerkungsdatei
geschrieben.

Phonetische Sonderzeichen sind zwischen spitzen Klammern zur Not moglich, sollten jedoch
vermieden werden. Sie mussen als ASCII-Zeichen geméaR den Praat-Regeln (s.0.) eingegeben
werden.

Sofern moglich, missen die Worter gemal der neuen deutschen Rechtschreibung eingegeben
werden.

Fremdsprachige Worter sollen, sofern sie erkannt werden, in der fiir diese Sprache tblichen
Schreibweise eingegeben werden. Nach Mdglichkeit soll die Vermittlersprache, nicht die
Ursprungssprache (Sprache des Etymons) angegeben werden. Wenn z.B. ein ungarisches
Wort Uber das Ruménische ins Siebenbirgisch-Sachsische gekommen ist, wird das Wort als
ruméanisch gekennzeichnet.

Worter, die nicht identifiziert werden konnen, sollen in naheliegender Orthographie - bei
strikter Vermeidung von Sonderzeichen! - den Horeindruck wiedergeben.

Beispiel:

Das Wort "zseb™ (ungar. flr "Hosentasche™)

- wird mit "Zseb" transkribiert, wenn es vom Transkriptor als ungarisch erkannt werden
wirde

- kénnte z.B. mit "Scheb" transkribiert werden, wenn es nicht erkannt werden wirde.

Einzelwdrter, die als fremdsprachlich identifiziert werden, werden folgendermal3en notiert:
Buchhalter<r>contabil</r>
Kulturheim<r>camin cultural</r>

Bei Mehrwortausdriicken wird der fremdsprachliche Ausdruck vorangestelit:
<<r>au venit dupa noi</r>>haben uns abgeholt</>

Probleme aller Art werden auf folgende Weise gekennzeichnet: {?Notiz(en)}

Wenn AuRerungen in die Notizen eingebaut werden, sind diese vom Kommentar durch
Doppelpunkte abzusetzen. Dialektausdriicke werden wie ublich in spitze Klammern gesetzt.
{?unversta#ndlich}

{?Stimme aus dem Hintergrund :auch drei:}



{?:<Zeach>:}

Aus Griinden des Datenschutzes diirfen Eigennamen von Personen *nicht transkribiert*
werden. An ihrer Stelle sind drei Gitterkreuze (###) zu schreiben.

Satzzeichen werden in den AuRerungen grundsatzlich *nicht* verwendet!
(Ausnahmen in geklammerten Notizen sind mdglich)

Anmerkungsdateien

Erklarungen, z.B. Bedeutungsangaben (Christtag - Anm. ,Weihnachten’) mussen in einer
gesonderten Datei abgelegt werden, fur die folgende Konventionen gelten:

e Jeder Anmerkung muss die zugeordnete Intervallnummer in eckigen Klammern und
gefolgt von einem Doppelpunkt (Beispiel: [15]: ) vorangestellt werden. Mehrzeilen-
Bereiche werden so notiert: [15-22]:

e Inder ersten Zeile der Datei muss der Dateiname stehen (Beispiel: ,,Datei 1445b-05).

e In der zweiten Zeile der Datei wird der Herkunftsort des Informanten angegeben
(Beispiel: ,,Anmerkungen zu Keisd*). Diese Uberschrift muss durch eine Leerzeile
von der ersten Anmerkung getrennt sein.

e Innerhalb einer Anmerkungseinheit dirfen keine Zeilenumbrtche vorkommen.

e Schlagworter zum Dateiinhalt als Ganzem werden vor den ersten intervallweisen
Anmerkungen notiert (Beispiel: ,,Schlagwoerter: Hanklich; Hochzeit; ...*).

e Am Ende der Datei, abgetrennt durch zwei Leerzeilen, muss der Name des Autors in
eckigen Klammern vermerkt werden.

e Bei der Datei muss es sich um eine reine Text-Datei in utf8-Kodierung handeln (auf
keinen Fall eine Word-Datei!).

e AuRer der einen Leerzeile zwischen Uberschrift und Anmerkungen und den zwei
Leerzeilen zwischen Anmerkungen und Verfassernamen darf die Datei keine
Leerzeilen enthalten.

e Der Dateiname muss aus der Nummer des Interviews und der Erweiterung ,,phon*
bzw. ,,orth” fiir die Art der Transkription und der Endung ,,txt* bestehen (Beispiel:
1445b-05.orth.txt).

Herunterladen der Audio-Dateien

Die Audiodateien des ASD kdnnen tber den Menupunkt "CORPUS" einzeln von der
Webseite des Projekts heruntergeladen werden:



UBER DAS PROJEKT

@ Datenbestand: 2212 Audiodateien; davon bislang transkribiert:138 | Anzahl gefundene Dateien: 1

WENKERSATZANALYSE alle Filter entfernen | Karte bei Google Earth

DOKUMENTE Audio Ort Jahr Alter Corpus Stichwiérter
|Fi|ter ﬂ I Filter ﬂ I Filt = I Filter j | Filter

Nummer der Audiodatei Zum Download der

Audio-Datei mit rechter
Maustaste anklicken und
“Ziel speichern unter...”
wahlen

Mit rechter Maustaste auf dieses Symbol klicken und .Ziel speichern unter ..." wahlen
In der Rubrik "Audio" erscheint die Nummer der Audio-Datei. Mit dieser Nummer muss die
Transkriptionsdatei benannt werden!
Das Herunterladen der Audiodatei ist erst nach Eingabe eines Passwortes moglich. Um dieses
Passwort zu erhalten, schicken Sie bitte eine Mail an thomas.krefeld@Imu.de oder

luecke@Imu.de. An diese Mailadressen senden Sie schlielich bitte auch die fertige
Transkriptionsdatei.

Ubersenden der Transkripte

Die fertigen Transkripte mussen in Form von "Textgrid-Dateien™ (erzeugt von "Praat”, s.u.)
uber folgende Internetadresse hochgeladen werden:

http://www.asd.gwi.uni-muenchen.de/index.php?intern=true&upload=true

Fur die Nutzung dieser Funktion bendtigen Sie eine Benutzerkennung, die wir Ihnen gerne
einrichten. Bitte wenden Sie sich an:

luecke@Imu.de oder thomas.krefeld@Imu.de

Grundsatzlich gilt: Die Textgrid-Dateien *mussen* denselben Namen wie die zugehérige
Audio-Datei besitzen (Beispiel: 566b-03.mp3 => 566b-03.TextGrid)

Bitte fertigen Sie zun&chst eine Probe-Transkription an und senden Sie diese an eine der
oben genannten Mailadressen!


mailto:luecke@lmu.de

e Anhang I: Das Transkriptionsprogramm "Praat™

Das Programm Praat ist von Phonetikern fir Phonetiker gemacht und besitzt einen
beeindruckenden Funktionsumfang. Aus Sicht der Korpuslinguistik ist es vor allem deswegen
interessant, weil damit Audio-Aufnahmen von Sprache transkribiert und fir die weitere
Verarbeitung mit Skripts und in Datenbanken aufbereitet werden kdnnen.

Praat ist kostenlos und fur alle gdngigen Betriebssysteme verfligbar. Es kann unter
http://www.fon.hum.uva.nl/praat/ heruntergeladen werden. Praat wird standig aktualisiert.
Man sollte sich stets die neueste Version von der Webseite der Entwickler herunterladen.

Das folgende Beispiel prasentiert die Transkription einer Audioaufnahme der Wenkersétze.

0. Starten des Programms

Das Programm wird durch Doppelklick gestartet. Praat 6ffnet automatisch zwei Fenster,
namlich "Praat Objects"” und "Praat Pictures”. Letzteres wird nicht bendétigt und kann gleich
wieder geschlossen werden.

=il 1=TEY

Praat Mew FRead ‘Write Help File Edit Margins World Select Pen Font Help
Objects: = ' 1 ' 2 ' 3 ' 4 ' 3 S

Fename... I Copy..
Inspect I {[ii=}

Hemnowve: I b | 1 -
4| L4 1] »

Codierung:

Bevor Sie mit dem Transkribieren beginnen, mussen Sie einmalig im Fenster "Praat Objects"
die Einstellungen anpassen. Dazu gehen Sie oben links auf “Praat"”, dann auf “Preferences /
Text writing preferences..." und wihlen UTF-8 aus.




1. Offnen der Audio-Datei

Gehen Sie auf "Read" und dann auf "Open long sound file ..."

Il Praat Objects

|Read

Open long sound file. ..

FEmove:

Bei mp3-Dateien erscheint folgende Meldung, einfach OK klicken und weiter:



Time measurements in MP3 files can be off by several tens of
milliseconds. Please convert to WAV file if you need time precision or

annotation.

2. Markieren Sie die ge6ffnete Audio-Datei in der Liste der "Objects" und klicken Sie auf
"Annotate” und anschlielend auf "To TextGrid..."

Il Praat Obhjects

1. LongSound ws

To TextGrid...




3. Praat fragt dann nach den Namen der sog. "Tiers". Damit sind zundchst Ebenen gemeint,
die fur die separate Transkription der AuBerungen verschiedener Sprecher gedacht sind. Im
Sinne der Korpuslinguistik hat es sich in vielen Fallen als guinstig erwiesen, unterschiedliche
grammatische Kategorien diesen Ebenen zuzuordnen. Entsprechend wiirde man "Satz",
"Wort" und "Silbe" als Tier-Namen wahlen. Die Entscheidung ist naturlich vom jeweils
verfolgten Forschungsinteresse abhangig.

Loschen Sie alle automatisch angelegten Eintrdge und legen Sie ein Tier namens "Satz" an, in
das der Text satzweise transkribiert wird:

x

Tier names: |Satz |

Puaint tigrs: | |

Help I Standards I Cancel | Apply | k. I

Nach dem Klick auf "OK" wird der Objektliste ein neuer Eintrag hinzugefugt, namlich
"TextGrid xx™:

JRI=TEY
Praat Mew FRead Write Help
Objects: TextGrid help =
1. LongSound ws | Edit
22 T eutlrid we Edit

& Sound: Edit?
Draw - I
List...
Dawn ta T able...
Guern - I b
Madify - |
Analyze
Extract tier. .
Rename. .. | Copp... | Extract part...
Synthezize
[hzpect | Info | Merge |

1] |

Remove | -
»

Nun mussen beide Listeneintrage gemeinsam markiert werden (dazu halt man beim
Mausklick die Strg-/Ctrl-Taste gedriickt):



o

Praat Mew Read Write Help
Objects: Edit -

Scale times

|nzpect

Hename... | [Eapy... I
|

[5je] I

< |
Ein Klick auf "Edit" 6ffnet folgende Ansicht:

Femove | -
»

=T
File Edit Query Wew Select Interval Boundary Tier Spectrum Pitch Intensity Formant Pulses Help
15.000000
06395 .
-0.5407 :

To see the analyses, E'ZI'ZII'I:J into atmost 10 seconds,

ar raise the “longest analysis™ setting with “Show analyses” in the View menu.

> 1 [ Satz
(1/1)

0 hell

2
(0)
15000000 | 15.000000
1] Visible part 30.000000 seconds 30.0000000 291.344195
Total duration 321.344195 seconds
all | i | u:uutI seII I:uakl 4| I ﬂp Group

Die GroRe des Ausschnitts lasst sich mit den kleinen Kndpfen am linken unteren Fensterrand
veréndern.

Nun folgt ein wichtiger Schritt: die Segmentierung der Audiodatei in einzelne Intervalle. Auf
alle Félle sollten Passagen unterschiedlicher Sprecher in jeweils eigene Intervalle gesetzt
werden. Am Anfang eines jeden Intervalls muss der Sprecher angegeben werden. Dabei wird
der Informant stets mit #1# bezeichnet. Weitere Sprecher werden in der Reihenfolge ihres
Auftretens mit #2#, #3# etc. bezeichnet. Sprechen mehrere Sprecher gleichzeitig, werden sie
zusammengefasst: #1,2,4# oder gegebenenfalls #alle#. Ist unklar, ob es sich bei einem
Sprecher um einen bereits aufgefuhrten oder einen neuen handelt, kann er mit #?# bezeichnet
werden.

Das Abspielen des Tons wird durch Driicken der Tabulator-Taste ausgeldst. Praat spielt nur
Ausschnitte von maximal 60 Sekunden L&nge ab. Bei langeren Ausschnitten erfolgt eine
entsprechende Fehlermeldung:



File Edit Query View Select Interwal Boundary Tier Spectrum  Pitch  Intensity  Formank  Pulses

=10l x|

Help

49 332414
x|
Sound too long (30 seconds), Cannot play, '8 data) h
0 seconds,
ar raise the “lengest analysis™ setting with 'Sh-j'-;n‘énal-,-'ses' inthe View menu. ‘
= 1 Satz
{1/1)
hell
2
{0)
49332414 | 21.0036345
0 Vigible part 80.33604%9 seconds 80.336049 241.008146
Total duration 321344195 seconds
all I in I n:nutI seII I:uakI ‘l I ﬂp Group

Die Definition eines Ausschnitts erfolgt durch das Ziehen der Maus bei gedriickter linker
Maustaste, wobei die Maus im Bereich der hier mit roten Pfeilen markierten Bereiche gefiihrt

werden muss.

Um eine Intervallgrenze zu setzen, muss man mit der linken Maus wiederum in einen der
beiden mit Pfeilen markierten Bereiche klicken. Es erscheint dann (auBer einer horizontalen,
fur uns irrelevanten) eine gestrichelte vertikale rote Linie, die jeweils an ihrem Schnittpunkt
mit den oberen Begrenzungslinien der Tiers (griine Pfeile) einen Kreis aufweist (blaue Pfeile).
Ein Klick in diesen Kreis erzeugt eine Intervallgrenze im entsprechenden Tier.

Die Intervallgrenzen werden durch vertikale Linien im entsprechenden Tier gekennzeichnet:

10



W 3. TextGrid ws -0 x|

File Edit Query View Select Interval Boundary Tier Spectrum Pitch Intensity Formant Pulses Help

Im Winter fliegen die getrockneten Blitter in der Lufc ':.e:"_;r:l

4.710931 ({0.212 )

9024233

04586

-0.3876 ;

Tao see the anal;.-'ses:. zoom into atmost 10 seconds,
or raize the “longest analysis’ sétting with “Show analyses” in the View menLi.

: T : : Satz

= 1 | | | Im Winter fliegen die g e
- - | | bell
2 (0)

4313307 | 4710931 | 1018
0 Visible part 10042008 seconds 10042006 311.302189
Total duration 321.344195 seconds
all I i I outI sel I hakI ‘l | ﬂp Graup

Die Auswahl eines Intervalls erfolgt durch Mausklick in den Bereich zwischen zwei vertikale
Linien (= Intervallgrenzen). Anschliel3end erscheint das Intervall rot hinterlegt, und es ist
maoglich, in den weillen Bereich (roter Pfeil) am oberen Rand des Fensters den
Transkriptionstext einzugeben. Schon bei der Texteingabe erscheint der Text zusétzlich im
entsprechenden Bereich des Tiers (in roter Schrift).

Praat erlaubt es nicht, phonetische Sonderzeichen zu verwenden. Erforderlichenfalls miissen
diese durch eine Abfolge von ASCII-Zeichen eingegeben werden. Die zu verwendenden
Zeichentabellen konnen durch Klicken auf das Hilfe-Meni abgerufen werden:

M 3. TextGrid ws o m] 3
File Edit Query View Select Interval Boundary Tier Spectrum PFitch Intensity Formant Pulses
Im Winter fliegen die getrockneten EBldtter in der Luft herum
TextGridEditor help  Cirl-Shift-?
About special symbols
4313307 4.?1[]_931 (0.212 7 5] 9024238 Phonetic symbols
0.4586 [ ] i out text styles
: : earch manual... Ctrl-M
0 o
-0.3876

To see the analyses, zoom in to at most 10 seconds,

ar raise the “longest analysis” setting with “Show analyses” in the View menu.

= 1 Im Winter fliegen die g fft;]
bell
2 (0)
4313307 | 4.710931 [ 1018
0 Visible part 10.042006 secands 10.042006 311.302159
Total duration 321.344195 seconds
o | _in | o] sel| bk () | |7 Groue

11



Hier ein Ausschnitt aus der Konsonanten-Tabelle:

File Goto Font

Voicelass plosive

voiced plos

I

m

m

imj

nasal

Der "retroflexe stimmlose Plosivlaut”, dessen phonetisches Symbol hier mit dem grunen Pfeil
markiert ist, muss in Praat mit der Zeichenfolge "\t." wiedergegeben werden.

Nach Abschluss der Transkriptionsarbeit kann der Text in eine sog. "TextGrid-Datei"
exportiert werden. Es empfiehlt sich, den Text zuvor geméall Unicode zu kodieren. Dieser
Schritt erfolgt Giber das Meni "Edit" -> "Convert entire TextGrid to Unicode™:

Ml 3. TextGrid ws -0l x|
File | Edit Query WView Select Interval Boundary Tier Spectrum Pitch Intensity Formant Pulses Help
Im T Undo Add boundary Ctrl-Z r in der Luft herum

Cut text Cirl-¥
—  Copy text Ctrl-C

S — 4 712262 {0.212 7 s5)

Erase text

Convert entire TextGrid to backslash trigraphs

Convert entire TextGrid to Unicode

Find...

Find again ¥

) i § { 1

0 Hz g0 L 4,.._4!" 'i.- . nhﬂ.}

) . - . Satz

= 1| Wenkers ||Im Winter fliegen d1e getrockneten |, .

\ bell
2
(0)
2 BR5855 | 4 634145
1.500000 |1.SUUUUU Visible part 7.500000 seconds 90000000 312 344195
Total duration 321344195 seconds

all | in | outl sell baklﬂJ ﬂp Group

AnschlieBend wird die Transkription Uber das Men( "File” und "Save TextGrid as text file" in

eine Textdatei geschrieben:
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I 3. TextGrid ws =101 %]
File Edit Query View Select Interval Boundary Tier Spectrum Pitch Intensity Formant Pulses Help

Luft herum rJ

Preferences... licter in der

Draty ta picture window:

Draw visible sound...

Draw selected sound...

Draw visible TextGrid. ..

Draw visible sound and TextGrid. ..

[ap)
(5]

4.712262 (0.212 + 5]

Exbract to abjects window:

Extract selected sound (preserve times)
Extract selected sound (time from 0}
Extract selected TextGrid (preserve times)
Extract selected TextGrid (time from zero)

Write ko disk:
Write selected sound to WAV file. ..
Write selected sound to AIFF file. ..

v 'L i HI‘ .I'
s ol W W L..'.j b
[ Winter fliegen die getrockneten ,Sff]

Write selected sound to AIFC file... hell
Write selected sound to Mext/Sun file. .. {0}
Write selected sound to NIST file. ..
Write selected sound to FLAC file... - I sl
Write TextGrid to text fle... isible part 7.500000 seconds 9.0000000 312344195
Wirite selected TextGrid to text file. . al duration 321 3441395 seconds
v G
MNew editor script ﬂ I Group

Open editor script...

Close Ctrl-w

Die dabei entstandene Datei kann anschlielend z.B. mit einem awk-Skript in Tabellenform
gebracht und dann in eine Datenbank importiert werden:

File type = "ooTextFile"
Object class = “TextGrid"

xmin o
xmax 321.3441958113379
tiers? <{exists>
size = 2
item []:
item [1]:
class = "IntervalTier"
name = "Satz"
%min = @
xmax = 321.3441958113379
intervals: size = 5
intervals [1]:
zmin = @
XMmax 1.08630635245981638
text
intervals [2]:
#min = 1.0630635245901638

®max = 2.8301618852459014

text = "Wenkersitze"

intervals [2]:
xmin = 2._.8301618852459014
Xmax = 4.365854508196721
text = “eins”

intervals [4]:
®min = 4.365854508196721
Xmax = 9.0878116803278688
text = "Im Winter fliegen die getrockneten Bldtter in der Luft herun

intervals [5]:
xmin = 9.878116803278688
xmax = 321.3441950113379
text = "

item [2]:

class = "TextTier"

name “bell™

Znin ]

Zmax = 321.3441958113379

points: size = @

13



Anhang I1: Konventionen zur Erfassung phonetischer Sonderzeichen geméaid "'Praat™

1. Vokale

close

close centralized

close-mid

open-mid

open

Other vowel symbols are:

s \sr (schwa with right hook): rhotacized schwa

How to remember the codes

For most of the codes, the first letter tells you the most similar letter of the English
alphabet. The second letter can be ¢ (furned), ¢ (capital), s (script), r (reversed), -
(barred or retracted), or / (slashed). One symbol (¢) 1s a phonetic version of a Greek

N
My A 1
BN G 0
1|y ||t |u| |w|u
i |y V- | - ‘mt| u
1Y (8]
Wie | ye ‘hs
e |0 9|0 Y| 0
e |[\oy e- | o rh | o
o)
\swW
e | 313 Al D
‘ef | \oe ver | \kb Wit | \ct
&£ e
\ae \at
a | E a|D
a [\Oe \as | \ab

letter. The codes for o, v, v and 3 are abbreviations for schwa, ram’s horn, horseshoe, and

kidney bean.
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2. Konsonanten

voiceless plosive

voiced plosive

nasal

volceless fricative

voiced fricative

approximant

trill

tap or flap

lateral approx.

implosive

click

Other consonant symbols:

P~ (1 with tilde ); velarized !

N
N 3 \‘v& @ 4 N
o N - o o o
FTIIIFTITIFTIFFs g8y
I T o s d dyFFyPaeEFHEe
R AR S I R G I A RS A
p |t (| |c k|q ?
p to] M i c k| q V- |\%g
b dd q ] g|aG
b d | dn il - Wgs | hge
I | 11) n Il 1 I} | N
m |imj n . \nj ng | ne
GO s|t|[|s|c|c Mm|X|y|h|H]h
i f \if s \I- |'sh | s, |\ce "'.C, Wi x |'cf [\h-[the| h
plviolz B|3|z|z]] y BT Y0
Wof | v [Mh| oz | Mz |\zh | 2. ['ze | e \af |\ ['\9e | \e- | tht
U 11 1 Iy |wiy
Ws || . i [t w |'ml

B I R
\be r \re

rl I

Vih | \f.

| | i, Wyt e
b d { d|d
bt Wt o gt | VGe
. |
Ol [T] [TT#]
V0. W1 Ve |- !
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[j\hj (heng with hookrop): the Swedish rounded post-alveolar & velar fricative

How to remember the codes

For most of the codes, the first letter tells you the most similar letter of the English

alphabet. The second letter can be ¢ (furned), ¢ (capital or curled), s (script), - (barred),

[ (with leg), i (inverted), or j (left tail ). Some phonetic symbols are similar to Greek
letters but have special phonetic (f) versions with serifs (¢, [}, y) or are otherwise slightly
different (0, ). The codes for 1) (engma), O (eth). [ (esh), and 5 (yogh) are traditional
alternative spellings. The retroflexes have a period in the second place, because an
alternative traditional spelling is to write a dot under them. The code for r is an
abbreviation for fishhook.

16



3. Diacritica
In line:

: \:f the phonetic length sign

"V'1 primary stress

V"2 secondary stress

| \|f the phonetic stroke

t' then (combining left angle above, corner ). unreleased plosive
3+ \et\hr (combining rhotic hook ): rhotacized vowel

Understrikes:

n n\|v (combining vertical line below ): syllabic consonant

b b\OvV (combining ring below): voiceless (e.g. lenis voiceless plosive, voiceless nasal
Or approximant)

0 o\Tv (combining down tack below, lowering ). lowered vowel; or turns a fricative
into an approximant

0 O\T" (combining up tack below, raising ): raised vowel; or turns an approximant into
a fricative

0 o\T( (combining left tack below, atr ): advanced tongue root

0 o\T) (combining right tack below, rir): retracted tongue root

e e\-v (combining macron below ). backed

0 0\+v (combining plus sign below): fronted

0 o\:v (combining diaeresis below ): breathy voice

0 o\~V (combining tilde below): creaky voice

d d\Nv (combining bridge below ). dental (as opposed to alveolar)

d d\Uv (combining inverted bridge below): apical

d d\Dv (combining square below ). laminal

uu\nv (combining inverted breve below): nonsyllabic

e e\3v (combining right half ring below ): slightly rounded

uu\cv (combining left half ring below): slightly unrounded

Overstrikes:

v \eD\O* (combining ring above): voiceless

g\ep\'* (combining acute accent ). high tone

eep\** (combining grave accent ). low tone

elep\-" (combining macron ): mid tone (or so)
g\ep\~" (combining tilde): nasalized

g\epW” (combining caron, hacek, wedge): rising tone
e\ep\™ (combining circumflex accent): falling tone|

0 o\ (combining djaeresis): centralized

e e\N” (combining breve ): short
kp ts k\ip (combining double inverted breve, ligature ): simultaneous articulation, or
single segment
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